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Gs •øÓø©PÒ1
ö\¯Ø£õk 1.1

RÊÒÍ ö\õØPøÍ¨ £¯ß£kzv CøhöÁÎPøÍ {μ¨¦P.

a) £zx SÔ±kPÒ £¯ß£kzu¨£kQßÓ Gs  •øÓø© ''''''''''''''''''''''''''''''' 
Gs •øÓø© BS®.

b) 1001
10

Gs •øÓø©°ß Ai ''''''''''''''''''''''''''''''' BS®.

c) '''''''''''''''''''''''''''''''  SÔ±kPøÍ¨   £¯ß£kzu¨£kQßÓ Gs •øÓø© 

'''''''''''''''''''''''''''''''''''' Gs •øÓø© BS®.

d) Gs •øÓø©ö¯õßÔÀ Põn¨£k® SÔ±kPÎß (Symbols)
GsoUøP AÆöÁs •øÓø©°ß ''''''''''''''''''''''''''''''' \©©õPU 

Põn¨£k®.

(C¸©, 2, Ai, 10, £vß©)

ö\¯Ø£õk 1.2

R÷Ç Põn¨£kQßÓ £vß©¨ ö£Ö©õÚ[PøÍ Â›zx GÊxP.

a)  52810  b)  18610  c)  30810

ö\¯Ø£õk 1.3

R÷Ç Põn¨£kQßÓ £vß©¨ ö£Ö©õÚ[PøÍ C¸© ö£Ö©õÚ[PÍõP 

©õØÔ GÊxP.

a) 2810  b) 4710  c) 10110 d) 12810 e) 17310

C»Á\¨ £õh¡À
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ö\¯Ø£õk 1.4

R÷Ç Põn¨£kQßÓ C¸©¨ ö£Ö©õÚ[PøÍ¨ £vß©¨ ö£Ö©õÚ[PÍõP 

©õØÔ GÊxP.

a)  100102           b)  110112       c)  10110112             d)  1111112 

e)  100000002

ö\¯Ø£õk 1.5

R÷Ç Põn¨£kQßÓ £hzøu¨ £¯ß£kzv uμ¨£mkÒÍ ÂÚõUPÐUS 

Âøh GÊxP.

ICT

0110110011001

01101100110

0110110011001

ICT

©õnÁº ICT GÝ® ö\õÀø»z umha_ ö\´²®÷£õx uμÄ 

£›©õÓ¨£kQßÓ SÔzu £i•øÓPÐUS›¯ C»UPzøu¨ £hzvß 

A®¦USÔ «x EÒÍ ÁmhzvÀ GÊxP.

£i•øÓ C»UP®  |øhö£Ö® ö\¯À

      ICT  GÝ®   ö\õÀø»z   umha_  ö\´²®÷£õx  uμÄ 

  C¸© •øÓ°À •øÓø© A»QØSÒ ö\À»À.

                
  PoÛ    {øÚÁPzvÀ    ÷\ªUP¨£mh    C¸©    uμÄ  

  öu›Â¨¤USa ö\ßÖ ICT GÝ® ö\õÀ öuß£hÀ.

  PoÛ  {øÚÁPzvÀ  ÷\ªUP¨£mi¸US®  C¸© uμÄ  

  Aa_¨ ö£õÔUSa ö\ßÖ ICT GÝ® ö\õÀ Aa]h¨£hÀ.

2

3

1 
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C¨£õhzvß AøÚzxa ö\¯Ø£õkPÐUS® Windows 10 £oö\¯À •øÓø© 

£¯ß£kzu¨£mkÒÍx.

£i•øÓ 1 -  ö£õzuõß«x ö\õhUQ  Windows System Gß£uß  RÊÒÍ 

  Control Panel «x ö\õhUPÄ®.

ö\¯Ø£õk 2.1  

E©x PoÛ°ß ÷|μ Á»¯® (Time Zone), vPv, ÷|μ®, |õn¯ A»S 

©ØÖ® Gs ÁiÁ® (Format) Gß£ÁØøÓ ©õØÔ Aø©¨÷£õ®.

·  CÆÁøÚzx ÁiÁ[PøÍ²® J÷μ Eøμ¯õhÀ ö£miUSÒ (Dialog 
Box) ÷©ØöPõÒÍUTi¯ ÁøP°À C¯UP •øÓø© Á\v¯ÎUQßÓx.

·  AuØ÷PØ£, CÆÁøÚzx ÁiÁ[PøÍ²® ÷©ØöPõÒÁuØSU R÷Ç 

Põmh¨£mkÒÍ £i•øÓPøÍ¨ ¤ß£ØÓÄ®.

1.1

1.2

1

£oö\¯À •øÓø©ø¯¨ £¯ß£kzv 

PoÛø¯ E¸Aø©ÁõUP¾® 

ÁiÁø©zu¾®
2
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£i•øÓ 2 -  Control Panel CÀ Date and Time «x ö\õhUPÄ®.

42

£i•øÓ 3 -   E©USU QøhUS® Eøμ¯õhÀ ö£mi°À Change Date and Time
«x ö\õhUPÄ®.  Cuß÷£õx QøhUS® Eøμ¯õhÀ ö£mi°À 

\›¯õÚ vPvø¯²® ÷|μ zøu²®  Aø©zx OK ö£õzuõß «x 

ö\õhUPÄ®. 

5 6

8

7

3 3.1

3.2

3.3

£i•øÓ 4 - Date and Time Eøμ¯õhÀ ö£mi°À Change Time Zone (÷|μ 

Á»¯®) ö£õzuõß «x ö\õhUPÄ®.  Cuß÷£õx QøhUS® 

Eøμ¯õhÀ ö£mi°À Time Zone GÝ® ChzvÀ Sri
Jayawardanapura    Gß£øuz  öu›Äö\´x OK  ö£õzuõß«x 

ö\õhUPÄ®. 
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9

10

11
4

4.2

4.1

£i•øÓ 5 - E©x PoÛ°ß ÷|μ®  ©ØÖ® vPv Gß£øÁ Põmh¨£k® 

ÁiÁzøuz öu›Äö\´÷Áõ®. Control Panel CÀ Region «x 

ö\õhUPÄ®. 

125

£i•øÓ 6 - E©USU   QøhUS®    Eøμ¯õhÀ    ö£mi°À   Formatඌ   «x  

ö\õhUQ¯ ¤ß, ÷uõßÖ® vPv ©ØÖ® ÷|μ ÁiÁ[PÎÀ }[PÒ 

Â¸®¤¯øuz öu›Äö\´x Apply ö£õzuõß «x ö\õhUPÄ®.
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13

14

15

6

6.1

6.2

£i•øÓ 7 -  E©x PoÛ°À  Põmh¨£kQßÓ C»UP  ÁiÁ®, AÍøÁ 

A»S ©ØÖ® |õn¯ A»S Gß£ÁØøÓz öu›Ä ö\´÷Áõ®. 

÷©¾ÒÍ Eøμ¯õhÀ  ö£mi°À  Põn¨£kQßÓ  Additional  
Settings  ö£õzuõß  «x   ö\õhUPÄ®.  Cuß÷£õx QøhUS® 

Eøμ¯õhÀ ö£mi°À Numbers Gß£øua ö\õhUQ¯ ¤ß, 

÷uõßÖÁÚÁØÔÀ Digit Grouping GÝ® £Sv°À ‰ßÔß 

öuõSvPÍõPU öPõsh C»UP ÁiÁzøu²® Measurement 
System GÝ® £Sv°À Metric Gß£øu²® öu›Äö\´x Apply 
ö£õzuõß «x ö\õhUPÄ®.

16

18

19

20

17

  7

  7.1

  7.2

  7.3

  7.4
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£i•øÓ 8 -  G©x   |õmiØS›¯ |õn¯ A»øP Aø©¨÷£õ®. CuØS,  

Currency «x ö\õhUQ¯ ¤ß, ÷uõßÖÁvÀ $ SÔ±miØS 

£v»õP Rs GÚ umha_ ö\´x OK ö£õzuõß «x ö\õhUPÄ®.

21

22

23

8

8.1

8.2

£i•øÓ 1 -  }[PÒ öu›Äö\´u ÷Põ¨¤ß «x Á»x ö\õhUQ¯Ähß (Right 
Click) QøhUS® £mi°À Properties «x ö\õhUPÄ®. Auß 

¤ß QøhUS® Eøμ¯õhÀ ö£mi°À ÷Põ¨¤ß ÁøP (Type of  
fi le)"  ÷Põ¨¤ß C¸¨¤h® (Location) ©ØÖ® ÷Põ¨¤ß AÍÄ 

(Size) Gß£ÁØøÓ E®©õÀ öuÎÁõP¨ £õºUP»õ®.

ö\¯Ø£õk 2.2

Caö\¯ø» ÷©ØöPõÒÁuØS }[PÒ {ºÁõPU PnUöPõßÔß (Adminisator 
Account) FhõPU PoÛ •øÓø©°À EÒ~øÇ¯ (Log in) ÷Ásk®. 

Caö\¯Ø£õmøh  E©x B]›¯º, E©US GkzxUPõmhõPa ö\´xPõmh 

•i²®. £s¦PøÍ £Ÿm]¨£uØS AÀ»x ©õØÖÁuØSz ÷uøÁ¯õÚ 

÷Põ¨ø£z öu›Äö\´x öPõÒÍÄ®. Auß ¤ß RÊÒÍ £i•øÓPøÍ¨ 

¤ß£ØÓÄ®.

PoÛU ÷Põ¨¦¨ £s¦  Aø©Ä

2
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1

2

3

  1.1

  1

  1.2

£i•øÓ 2 - }º öu›Äö\´u ÷Põ¨¤øÚ¨ £õxPõ¨£uØPõÚ C¸ Â÷\h 

£s¦PÒ C[S EÒÍhUP¨£mkÒÍÚ. AÁØÔÀ JßÖ 

÷Põ¨¤øÚ  ̄ õ¸US®  öuß£hõuÁõÖ ©øÓzx  (Hidden) øÁzuÀ 

©ØÖ® v¸zu[PøÍ ÷©ØöPõÒÍõx Áõ]¨£uØS ©õzvμ® (Read 
Only) AÝ©v¯ÎzuÀ. C¨£s¦PøÍa ö\¯Ø£kzxÁuØS 

QøhUP¨ö£ØÔ¸US® Eøμ¯õhÀ ö£mi°À Properties 
Gß£uß •ßÚõ¾ÒÍ \›£õºzuÀ ö£mi°À ö\õhUSÁuß 

‰»® \› Aøh¯õÍªkuÀ ÷Ásk®. C¨£s¦PÎÀ JßøÓ 

AÀ»x Cμsøh²® J÷μ ÷|μzvÀ ö\¯Ø£kzu •i²®. 

CuØSU RÊÒÍ £i•øÓPøÍ ÷uøÁU÷PØÓÁõÖ ¤ß£ØÓÄ®. 

\›£õºzuÀ ö\´u ¤ß Apply ö£õzuõß «x ö\õhUPÄ®.
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4

5

6

7

£i•øÓ 1 - •u¼À   ÷Põ¨¦PøÍ    Bμõ´ÁuØS    File Explorer    Gß£uØSa  

ö\À÷Áõ®. ö£õzuõß «x Á»x ö\õhUPÄ®. Cuß÷£õx 

÷uõßÖ® £mi¯¼À File Explorer Gß£uß «x ö\õhUPÄ®. 

ö\¯Ø£õk 2.3

•  E©x PoÛ°À £õxPõUP¨£mh ÷Põ¨ö£õßÖ «sk® ÷uøÁ¨£k® 

\¢uº¨£® JßÔÀ AU÷Põ¨¦ C¸US® Ch® ©Ó¢v¸¨¤ß, ÷Põ¨¤ß 

ö£¯º, ÷Põ¨¦ ÁøP, ÷\ªUP¨£mh vPv ÷£õßÓÁØøÓU öPõsk, 

AU÷Põ¨¤øÚ E[PÍõÀ Psk¤iUP •i²®. ÷Põ¨¦ ÁøP°ß 

Ai¨£øh°À ÷Põ¨ö£õßøÓz ÷uk® ÂuzøuU PshÔ÷Áõ®. ÷Põ¨¦ 

ÁøP öu›²©õ°ß PoÛ°À Põn¨£k® AÆÁøPU ÷Põ¨¦PÒ 

AøÚzvÚx® £mi¯ø»¨ ö£ØÖUöPõÒÍ •i²®. ÷Põ¨¦¨ 

ö£¯öμõßÔß ÷Põ¨¦ ÁøPø¯U SÔ¨£x ÷Põ¨¦¨  ö£¯øμz öuõhº¢xÒÍ 

}m] (Extention) BS®. BP÷Á, A¢}m]ø¯¨ £¯ß£kzv AÆÁøP 

AøÚzx ÷Põ¨¦PøÍ²® GÆÁõÖ ÷ukÁöuß£øu¨ £õº¨÷£õ®. 

•  Euõμn©õP ""docx'' }m]²øh¯  AøÚzxU ÷Põ¨¦PøÍ²® ÷uk÷Áõ®. 

R÷Ç uμ¨£mkÒÍ £i•øÓPøÍ¨ ¤ß£ØÓÄ®. C[S docx, Microsoft  
Word ö\¯¼¯õÀ E¸ÁõUP¨£k® ÷Põ¨¦PÎß }m] BS®.

  2   3

  2.1   3.1
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£i•øÓ 2 - File Explorer  Gß£uß  Á»x  £UP ÷©À ‰ø»°À Põn¨£k® 

" Search  quick Access "   GÝ®   ChzvÀ  }[PÒ ÷uk® ÷Põ¨¦ 

}m]ø¯ docx GÚ   umha_  ö\´P.  Cuß  ¤ß,  ÷uh  ÷Ási¯   

Ch©õP   This  PC   «x ö\õhUPÄ®. E©x ÷uh¾US Aø©ÁõP 

PoÛ°À C¸US® docx }m]²øh¯ AøÚzxU ÷Põ¨¦PÐ® 

öuß£k®. A¨£mi¯¼À C¸¢x E©USz ÷uøÁ¯õÚ 

÷Põ¨¤øÚz öu›Äö\´¯Ä®.

32

   

1.2

   

42.1
52.2

Computer ManagementComputer Management

Task ManagerTask Manager

SettingsSettings

File ExplorerFile Explorer

SearchSearch

RunRun

Shut down or sign outShut down or sign out

DesktopDesktop

Search Quick accessQuick access

Desktop Downloads Documents Pictures

docx

d a search f ilter
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ö\¯Ø£õk 2'4

R÷Ç Põn¨£kQßÓ ö\õØPÎÀ ªPÄ® ö£õ¸zu©õÚ ö\õÀø»z öu›Äö\´x 

CøhöÁÎ  {μ¨£Ä®.

1. ........................... ©ØÖ® ......................... Gß£Ú PoÛ²hß 

öuõÈØ£k®÷£õx  A÷|P©õP  £¯Úº •P[öPõkUP ÷Ási¯ ¤μa]øÚ 

PÍõS®.

2. Âø\¨£»øP ©ØÖ® _mi Gß£Ú ö\¯Ø£hõø© ................... BS®.

3. PoÛ²hß CønUP¨£mi¸US® AøÚzx Áh[PøÍ²® £Ÿm]¨£uØS 

•ß ........................ ö\´¯¨£kuÀ ÷Ásk®. 

4. Âø\¨£»øP ©ØÖ® _mi Gß£ÁØÔØS.................. xøÓ AÀ»x 

................... xøÓ £¯ß£kzu •i²®.

5. RJ - 45 Cøn¨¤ Eøh¯ Áh® ö£õ¸zu¨£kÁx PoÛ°ß ............... 

CØPõS®.

6. PoÛUS öuõø»UPõm]¨ ö£mi CønUP¨£k®÷£õx £¯ß 

£kzu¨£kÁx ........................... Áh©õS®. 

7. PoÛø¯¨ £¯ß£kzx®÷£õx HØ£kQßÓ A÷|P ¤μa]øÚPÐUS J¸ 

wºÁõP Aø©Áx PoÛø¯ ......................ö\´ÁuõS®.

8. PoÛ²hß CønUP¨£mi¸US® ]» Áßö£õ¸ÒPÒ •øÓ¯õP 

ö\¯Ø£hõø©USU Põμn® AÆÁßö£õ¸ÒPÎß ......................... 

{ÖÁ¨£hõø©¯õS®.

9. ................ öÁØÔh® SøÓÁõS®÷£õx PoÛ ö\¯Ø£k® ÷ÁP® 

SøÓÁøh²®.

10. PoÛ°ß ö\¯ØÔÓøÚ AvP›¨£uØS A|õÁ]¯©õÚ ö©ßö£õ¸ÒPøÍ 

..................................ö\´¯ ÷Ásk®.

Duºö|Ø xøÓ,  PS / 2" HDMI, ö\¾zv ö©ßö£õ¸Ò, {ÖÁÀ }UPÀ (Uninstall), 
ªß  Â{÷¯õPz  xsi¨¦,  «Ò öuõhUP® (Restart),  Áßö£õ¸Ò\õº  uÁÖ,  

¤μuõÚ  ÷\ª¨£PzvÀ, USB, {ÖÄuÀ (Install), ö©ßö£õ¸Ò\õº uÁÖ. 
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ö\¯Ø£õk 2'5

R÷Ç Põn¨£kQßÓ AmhÁøn°À C¸US® £hzvØS›¯ B[Q» GÊzvØS¨ 

ö£õ¸zu©õP CμshõÁx {μ¼À AuØS›¯ ö£¯¸US •ßÚõ¼¸US® 

CøhöÁÎ°À GÊuÄ®.

A DVI xøÓ
''''''''''''''''

B VGA  xøÓ ''''''''''''''''

C HDMI xøÓ ''''''''''''''''

D eSata xøÓ ''''''''''''''''

E Parallel xøÓ ''''''''''''''''

F SD card reader ''''''''''''''''

G Micro USB xøÓ ''''''''''''''''

H RJ-45 Duºö|Ø xøÓ ''''''''''''''''

I HD Audio xøÓ ''''''''''''''''
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ö\¯Ø£õk 2'6

R÷Ç Põn¨£kQßÓ £À÷uºÄ ÂÚõUPÐUSz uμ¨£mkÒÍ ÂøhPÎÀ 

C¸¢x \›¯õÚ Âøhø¯z öu›Äö\´x Auß RÌU ÷PõikP.

1. PoÛ²hß ö\¯À£k® E[PÐUS A÷|P©õP •P[öPõkUP   

÷|›k® ¤μuõÚ ¤μa]øÚPÒ Cμsk EÒÍÚ. AøÁ¯õÁÚ,

a. ‰»uÚ¨ ¤μa]øÚPÐ® ö©õÈ¨ ¤μa]øÚPÐ®

b. Pou¨ ¤μa]øÚPÐ® Áßö£õ¸Ò\õº ¤μa]øÚPÐ®

c. ö©ßö£õ¸Ò\õº ¤μa]øÚPÐ® Áßö£õ¸Ò\õº ¤μa]øÚPÐ®

d. ö©ßö£õ¸ÒPÒ\õº ¤μa]øÚPÐ® ö©õÈ¨ ¤μa]øÚPÐ®

2. GÎ¯ Áßö£õ¸Ò\õº ¤μa]øÚö¯õßÔØS Euõμn©õP Aø©Áx,

a. C¯UP •øÓø© ö\¯¼ÇzuÀ

b. _mi ö\¯Ø£hõø©

c. PoÛ ö\¯Ø£h Bμ®¤¨£uØS AvP ÷|μ® GkzuÀ

d. ¤μuõÚ ÷\ª¨£PzvÀ öÁØÔh® SøÓuÀ

J RJ-45 öuõk¨¤
''''''''''''''''

K PS 2 xøÓ ''''''''''''''''

L USB xøÓ ''''''''''''''''
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3. PoÛö¯õßÖ Áø»¯ø©¨¦hß öuõhº¦£hõv¸¨£uØS 

Põμn©õP Aø©¯UTi¯x,

a. ö©ßö£õ¸Ò\õº ¤μa]øÚ¯õS® 

b. Áßö£õ¸Ò\õº ¤μa]øÚ¯õS®

c. |a_{μÀ öuõØÓõS®

d. ÷©ØTÔ¯ AøÚzx Âh¯[PÐ©õS®

4. PoÛø¯ C¯UP •i¯õu \¢uº¨£zvÀ PoÛUS ªß\õμ® 

QøhUQßÓuõ Gß£øu £Ÿm]UP ÷|›k®. CÆÁõÓõÚ \¢uº¨£zvÀ 

}[PÒ •u¼À ö\´¯ ÷Ási¯x,

a. PoÛUS ªß\õμ® Â{÷¯õQUQßÓ Áhzøu |ßÓõP¨   

 ö£õ¸zxu»õS®

b. UPS CØS ªß\õμ® Â{÷¯õQUQßÓ Áhzøu¨ £Ÿm]zu»õS®

c. ¤μuõÚ ÁÇ[Q°ß ªß\õμ Â{÷¯õPzøuz xsizu»õS®

d. PoÛø¯ C¯US® ö£õzuøÚ AÊzu»õS®.

5. R÷Ç Põn¨£kQßÓ \õuÚ[PÎÀ PoÛ°ß USB xøÓø¯¨ 

£¯ß£kzv PoÛ²hß öuõhº¦£kzu •i¯õu \õuÚ©õP 

Aø©Áx,

a. Aa_¨ö£õÔ¯õS®

b. öu›Â¨¤¯õS®

c. Á¸i¯õS®

d. Âø\¨£»øP¯õS®

6. PoÛUS öuõø»UPõm]¨ ö£miö¯õßøÓ (TV) öuõhº¦£kzu 

÷Áskö©Ûß AuØS ªP¨ ö£õ¸zu©õÚ xøÓ¯õP Aø©Áx,

a. USB xøÓ¯õS®

b. DVI xøÓ¯õS®

c. eSata xøÓ¯õS®

d. HDMI xøÓ¯õS®

7. PoÛUS öu›Â¨¤ö¯õßøÓ öuõhº¦£kzu •i¯õu xøÓ¯õP 

Aø©Áx,

a. DVI xøÓ¯õS®

b. USB xøÓ¯õS®

c. VGA xøÓ¯õS®

d. HDMI xøÓ¯õS®
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8. E©x PoÛ°À Â›uõÒ ö©ßö£õ¸øÍz  vÓUP •i¯õxÒÍx. 

CuØS Põμn©õP Aø©¯UTi¯x,

a. |a_{μÀ ö\¯Ø£õhõS®

b. Â›uõÒ ö©ßö£õ¸Ò £Êuøh¢v¸zu»õS®

c. C»Á\©õP £Ÿm\õºzuzvØöPÚ uμ¨£mh Põ»® •iÁøh¢   

 uø©¯õS®

d. ÷©ØSÔ¨¤mh H÷uÝ® J¸ PõμnzvÚõ»õP C¸UP»õ®

9. eSata xøÓ RÊÒÍ Ga\õuÚzøuz öuõhº¦£kzxÁuØS¨ £¯ß 

£kzu¨£kQÓx.

a. öu›Â¨¤

b. Âø\¨£»øP AÀ»x _mi

c. E¯º ©mh (HD) J¼ö£¸UQ

d. öÁÎ¨¦Ó ÷\ª¨¦a (Storage) \õuÚ®

10. PoÛUS öuõhº¦£kzu¨£kQßÓ ö£¸®£õ»õÚ \õuÚ[PÒ AÁØ 

ÔØ÷P E›zuõÚ £À÷ÁÖ xøÓPÒ FhõPz öuõhº¦£kzu¨£kÁx 

Bμ®£ Põ»zvÀ C¸¢u ÷£õv¾® öuõÈÝm£zvß ÁÍºa]²hß 

A÷|P©õÚ \õuÚ[PÒ ö£õ¸¢uUTi¯ ö£õxz xøÓö¯õßÖ |ÃÚ 

PoÛPÎÀ PõnUTi¯uõP EÒÍx. AzxøÓ¯õÁx,

a. HDMI xøÓ¯õS®

b. eSata xøÓ¯õS®

c. DVI xøÓ¯õS®

d. USB xøÓ¯õS®
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ö\õÀ •øÓÁÈ¨£kzuÀ  ö©ßö£õ¸Îß   ÁøμPø»  £¯Úº  Cøh•Pzvß 

(Graphical user Interface) P¸ÂPÒ ]»ÁØøÓ CÆÁõÖ Aøh¯õÍ® Põs÷£õ®.

÷|º¨£kzuÀ ©ØÖ® {ø»¨£kzuÀ P¸ÂPÒ

(Alignment and Positioning Tools)

umha_ ö\´ÁuØPõÚ 

{ø»Põmi

(Cursor point)

GÊzx ÁiÁø©¨¦U P¸Â

(Text Formatting Tools)

  

ö\õÀ •øÓÁÈ¨£kzuÀ3
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·   £¢v, ÁõUQ¯® AÀ»x ö\õÀ Gß£ÁØøÓz öu›Äö\´²® Âu®

ö\¯Ø£õk 3.1

• R÷Ç Põn¨£k® BÁnzøu |ßS Bμõ´¢x AuøÚ ÁiÁø©¨£uØS¨ 

(Formating) £¯ß£kzu¨£mkÒÍ P¸ÂPÒ GøÁ Gß£øuU R÷Ç 

SÔ¨¤hÄ®.

an apple

An apple can taste very nice,
Try a bite or a slice,
If it’s red or if it’s green,
It will taste good if it’s clean.

My grandma says “ An apple day,
always keeps the doctor away”

2

3

4
1

6

5

1' ''''''''''''''''''''''''''''''''''''''      4' ''''''''''''''''''''''''''''''''''''''

 2' ''''''''''''''''''''''''''''''''''''''      5' ''''''''''''''''''''''''''''''''''''''

 3' ''''''''''''''''''''''''''''''''''''''      6' ''''''''''''''''''''''''''''''''''''''

ö\¯Ø£õk 3.2

÷©÷» Põmh¨£mkÒÍ BÁnzøu E¸ÁõUS® ÂuzøuU PØ÷£õ®.

£i•øÓ 1 -  G©x PoÛ°À C¸US® ö\õÀ •øÓÁÈ¨£kzuÀ 

ö©ßö£õ¸ÍõÚ (Word Processing Software) Microsoft 
Offi  ce Word 2013 I vÓ¢xöPõÒÍÄ®. 

¦v¯ BÁnö©õßøÓ E¸ÁõUSÁuØS ¦v¯ 

£UPö©õßøÓ¨ ö£ØÖUöPõÒÐ® Âu®.

File → New → Blank Document öu›Äö\´P.

£i•øÓ 2 - Âø\¨ £»øPø¯¨ £¯ß£kzv, {ø»Põmi C¸US® 

ChzvÀ Bμ®¤zx R÷Ç Põmh¨£mkÒÍ BÁnzøu 

umha_ ö\´¯Ä®.
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£i•øÓ 3 -  umha_ ö\´u ¤ß Áiø©zuø» ÷©ØöPõÒÁuØPõÚ 

£¢v, Á\Ú® AÀ»x ö\õÀø»z öu›Äö\´xöPõÒÍ 

÷Ásk®. (Select the Text)
uÛ GÊzøu 

AÀ»x £» 

GÊzxUPøÍ

_miø¯ AÊzv¯ÁõÖ GÊzxUPÐUS ÷©»õP CÊUPÄ®.

J¸ ö\õÀø» ö\õÀ¼ß «x Cμmøha ö\õhUSa ö\´¯Ä®.

£» ö\õØPøÍ öu›Ä ö\´¯ ÷Ási¯ ö\õØPÎß  Bμ®£zvÀ C¸¢x 

_miø¯ AÊzv¯ÁõÖ Pøh] ö\õÀ ÁøμUS® ÷©»õP 

CÊUPÄ®.

ÁõUQ¯ö©õßÖ ÁõUQ¯zvß Bμ®£zvÀ C¸¢x _miø¯ AÊzv¯ÁõÖ 

ÁõUQ¯zvß CÖv ÁøμUS® AÆÁõUQ¯zvß ÷©»õP 

CÊUPÄ®.

Á›ø\ö¯õßÖ Á»¨£UP®  \›¢u  öÁs{Ó  A®¦USÔ ÷uõßÖ® Áøμ 

_mi°ß Põmiø¯ Á›°ß Ch¨£UP ÂÎ®¤ØS öPõsk 

ö\À»Ä®. A®¦USÔ öuß£k®÷£õx _miø¯a ö\õhU 

PÄ®. 

£¢vö¯õßÖ £¢v°ß «x •aö\õhUS ö\´¯Ä® AÀ»x

£¢v°ß Bμ®£zvÀ C¸¢x CÖv Áøμ _miø¯ AÊz-

v¯ÁõÖ CÊUPÄ®.

•Ê 

BÁnzøu²®

Âø\¨£»øP°À Ctrl + A \õÂPøÍ J÷μ \©¯zvÀ 

AÊzuÄ®.

  

An Apple

An apple can taste very nice,
Try a bite or a slice,
If it’s red or if it’s green,
It will taste good if it’s clean.
My grandma says “An apple a day,
Always keeps the doctor away”

PÁÚzvØS :
ÁõUQ¯ö©õßÔß •iÂÀ Âø\¨ £»øP°ß ~øÇÄa (Enter)
\õÂø¯ AÊzv Akzu Á›USa ö\À» ÷Ásk®. (£mi¯À, 

uø»¨¦ ©ØÖ® uÛ ÁõUQ¯® Gß£ÁØÔØS) GÛÝ®, 

£¢vö¯õßøÓz umha_ ö\´²®÷£õx £¢v •i²® Áøμ  

öuõhº¢x    umha_    ö\´x    £¢v°ß     CÖv°À ~øÇÄa

\õÂø¯ AÊzxÁuß ‰»® £¢vø¯ •iUPÄ®.



19

£i•øÓ 4 -  öu›Äö\´u £¢v, Á\Ú® AÀ»x ö\õÀø» ö\õÀ•øÓ 

ÁÈ¨£kzuÀ ö©ßö£õ¸Îß Home uõÁ¼ß Font SÊÂÀ  

C¸US® ÷uøÁ¯õÚ ÁiÁø©zuÀ P¸Â «x ö\õhUQ 

ÁiÁø©¨ø£ ÷©ØöPõÒÍ ÷Ásk®.

£i•øÓ 5 -  Auß ¤ß  E¸ÁõUQ¯  BÁnzøua ÷\ªUP ÷Ásk®.

BÁnzøua ÷\ªUS® Âu®

² File → Save öu›Äö\´¯Ä®.

² ÷\ª¨£uØS¨ ö£õ¸zu©õÚ Chzøu (Saving Location) Save 
in GÝ® ChzvÀ öu›Äö\´¯Ä®.

² BÁnzvØS¨ ö£õ¸zu©õÚ ö£¯øμ File name Gß£uØS 

Gv÷μ umha_ ö\´¯Ä®.

² Save ö£õzuõøÚa ö\õhUPÄ®.

HØPÚ÷Á ÷\ªUP¨£mh BÁnzøu ÷ÁöÓõ¸ ö£¯›À 

÷\ªUS® Âu®

² File → Save as öu›Ä ö\´¯Ä®.

² ÷\ª¨£uØS¨ ö£õ¸zu©õÚ Chzøu Save in GÝ® 

ChzvÀ öu›Äö\´¯Ä®.

² BÁnzvØS¨ ö£õ¸zu©õÚ ö£¯øμ File name Gß£uØS 

Gv÷μ umha_ ö\´¯Ä®.

² Save ö£õzuõøÚa ö\õhUPÄ®.

£i•øÓ 6 - ÷\ªzu ¤ß BÁnzøu ‰iÂhÄ®.

BÁnzøu ‰k® Âu®

File → Close öu›Äö\´¯Ä®.
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ö\¯Ø£õk 3.3  

• R÷Ç uμ¨£mkÒÍ BÁnzøu |ßS Bμõ´¢x Auß ÷|º¨£kzuÀ 

©ØÖ® {ø»¨£kzuÀ (Alignment and Positioning) Gß£ÁØÔØS¨ 

£¯ß£kzu¨£mkÒÍ P¸ÂPøÍ CÚ[Psk R÷Ç SÔ¨¤hÄ®.

Save Trees, Save Mother earth

Things to do…

1. Plant a tree and get oxygen for free
2. If you cut a tree you cut your life
3. The tree is your friend
4. Feel free to plant a tree
5. Trees are the roots of all living beings
6. A tree that stays, keeps fl ood away

√ Protect trees
√ There is no life without Green
√ Take care of trees, they will take care of you

                     Connecting people to Green

Save trees and protect Mother Earth from 
global warming. Don’t destroy the greenery 
and don’t spoil the scenery. Save mother Earth.

1

3

6}
4 }

}5

2

7

8

 1' ''''''''''''''''''''''''''''''''''''''  5' ''''''''''''''''''''''''''''''''''''''

 2' ''''''''''''''''''''''''''''''''''''''      6' ''''''''''''''''''''''''''''''''''''''

 3' ''''''''''''''''''''''''''''''''''''''      7' ''''''''''''''''''''''''''''''''''''''

 4' ''''''''''''''''''''''''''''''''''''''      8' ''''''''''''''''''''''''''''''''''''''
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ö\¯Ø£õk 3.4

• ÷©÷» Põmh¨£mkÒÍ BÁnzøu E¸ÁõUS÷Áõ®.

£i•øÓ 1 -  BÁnzøu   E¸ÁõUSÁuØS¨   ¦v¯   £UPö©õßøÓ¨   

ö£ØÖUöPõÒÍÄ®.

£i•øÓ 2 - R÷Ç  Põmh¨£mkÒÍÁõÖ  BÁnzøu ¦v¯ £UPzvÀ  

umha_ ö\´¯Ä®.

£i•øÓ 3 - ÷uøÁ¯õÚ  £¢v, Á\Ú® AÀ»x ö\õØPøÍz öu›Ä 

ö\´x  ÷©¾ÒÍ    ö\¯Ø£õmiÀ    Põmh¨£mhÁõÖ   

E¸ÁõUPÄ®.

£i•øÓ 4 - Auß¤ß E¸ÁõUQ¯ BÁnzøua ÷\ªzu ¤ß AuøÚ 

‰iÂhÄ®.

Save Trees, Save Mother earth

Save trees and protect mother earth from global warming. 
Don’t destroy the greenery and don’t spoil the scenery. Save 
mother earth.

Things to do…

Plant a tree and get oxygen for free
If you cut a tree you cut your life
The tree is your friend
Feel free to plant a tree
Trees are the roots of all living beings
A tree that stays, keeps fl ood away
Protect trees
There is no life without Green
Take care of trees, they will take care of you

Connecting people to Green
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ö\¯Ø£õk 3.5

• R÷Ç Põmh¨£mkÒÍÁõÖ  BÁnzøu E¸ÁõUQ ÷\ªUPÄ®

Computer Software
Softwares are logical components of computer, which 
can't be seen and touched. Software's are used to run the 
computer in effi  cient manner. Without software; computer 
is like a vehicle without fuel. There are three major types 
of software:

1. System Software

2. Application Software

3. Utility Software and Service Programme

System Software:

System softwares are those which are provided by

manufacturers to the user. They are used to control the

computer system and increase computer performance.

ö\¯Ø£õk 3.6 

• R÷Ç uμ¨£mkÒÍ _Áöμõmiø¯ |ßS B´Ä ö\´P. Aøu 

E¸ÁõUSÁuØS¨ £¯ß£kzu¨£mhøÁPÒ R÷Ç Põmh¨£mkÒÍÚ.
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1

2

3

6

4

5

1. Âzv¯õ\©õÚ GÊzx¸öÁõßøÓ¨ £¯ß£kzv, GÊzx AÍøÁ 

©õØÔ, Áºnªmk ©zv°À {ø»¨£kzu¨£mkÒÍx.

2. £hö©õßÖ ©zv°À {ø»¨£kzu¨£mkÒÍx.

3. ö\õØPø» (WordArt) ¤μ÷¯õQUP¨£mkÒÍx.

4. GÊzx¨ ö£mi (Textbox) £¯ß£kzva ö\õØPÒ umha_ ö\´¯¨ 

£mkÒÍÚ.

5. Áºnªh¨£mh ÁiÁö©õßÔØSÒ umha_ ö\´¯¨£mkÒÍx.

6. £UPU Pøμ (Page Border) ¤μ÷¯õQUP¨£mkÒÍx.
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÷©÷» uμ¨£mkÒÍ _Áöμõmiø¯ E¸ÁõUS÷Áõ®.

£i•øÓ 1 -  BÁnzøu E¸ÁõUSÁuØS ¦v¯ £UPö©õßøÓ¨   

ö£ØÖUöPõÒÍÄ®.

£i•øÓ 2 -   Bμ®£zvÀ uμ¨£mkÒÍ  3  

Á›PøÍz umha_ ö\´¯Ä®.

£i•øÓ 3 -  AÆÁ›PøÍz öu›Äö\´x E¸ÁõUPzvØS¨ ö£õ¸zu©õÚ 

GÊzx ÁøPö¯õßøÓz öu›Äö\´x, GÊzx AÍøÁ ©õØÔ, 

Áºnªmk ©zv°À {ø»¨£kzuÄ®.

BÁnzvØS¨ £hö©õßøÓa ÷\ºzuÀ

£i•øÓ  4 -  £h® ÷uøÁ¨£k® ChzvÀ _miø¯a ö\õhUPÄ®.

   Insert    Pictures  →  Online   ⁄  Pictures  Gß£øuz  öu›Äö\´¯Ä®. 

Pictures Gß£øuz öu›Äö\´ÃºPöÍÛß A¨÷£õx 

QøhUS® Insert Pictures \õÍμzvÀ Â¸®¤¯ £hzvß «x 

ö\õhUQ Insert ö£õzuõøÚa ö\õhUPÄ®

£i•øÓ  5 -  Online   Pictures     öu›Äö\´¯¨

 £mhõÀ, Auß¤ß QøhUS® 

Insert Pictures \õÍμzvÀ Â¸®¤¯ 

£hö©õßÔß «x ö\õhUQ Insert
ö£õzuõøÚa ö\õhUPÄ®.

£i•øÓ  6 - ö£ØÖUöPõsh £hzøuz ÷uøÁ 

¯õÚ AÍÂØS Aø©zuÀ. CuØS 

£hzvß «x ö\õhUPÄ®.

£i•øÓ  7 - £hzvß AÍÄ ©õØÓÀ øP¨ 

¤iø¯¨ (Resizing Handle) £¯ß 

£kzv £hzvß AÍøÁ ©õØÓ 

•i²®.

BÁnzvÀ ö\õØPø» (Word  Art) ÷\ºzuÀ

£i•øÓ  8 - ö\õØPø»  ÷uøÁ¨£k®  ChzvÀ  _miø¯a  ö\õhUPÄ®.

SATURDAY MAY 25th

10 am - 4 pm
At school ground
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£i•øÓ  9 - Insert →  Word   Art   «x ö\õkUQ

   ö\õØPø» ÁiÁzøu öu›Ä 

ö\´¯Ä®.

£i•øÓ 10 - Auß ¤ß ''KIDS FUN DAY''   
GÚ umha_ ö\´¯Ä®.

£i•øÓ 11 - BÁnzvÀ   ÷uõßÔ¯  ö\õØPø»       

 ÁiÁzvß «x ö\õhUPÄ®. 

£mi°À Word Art style CÀ 

C¸US® Text Eff ect → Transform 
FhõP \›¯õÚ ÁiÁzøuz öu›Ä 

ö\´P.

£i•øÓ 12 - ''KIDS  FUN  DAY''  «x ö\õhUQ 

AuøÚ J¨£øh°À Põmi¯ÁõÖ 

©zv°À {ø»¨£kzuÄ®.

£i•øÓ  13 -  ''KIDS  FUN  DAY'' Gß£uØSU 

RÇõP uμ¨£mkÒÍ 2 Á›PøÍ 

umha_ ö\´¯Ä®.

£i•øÓ  14 -  Aaö\õØPøÍz öu›Äö\´x 

E¸ÁõUPzvØS¨ ö£õ¸zu©õÚ 

GÊzx   ÁøPö¯õßøÓz   öu›Ä

 ö\´x, GÊzx AÍøÁ ©õØÔ, 

Áºnªmk ©zv°À {ø»¨£kzuÄ®.

BÁnzvØS GÊzx¨ö£mi (Text Box) ÷\ºzuÀ

CHALLENGES
KIDS' YOGA
DANCING

TASTY FOOD 
GAMES 
PRIZES

ENTERTAINMENT
FACE PAINTING
SIDEWALK SALE

£i•øÓ 15  -  Insert → Text box → Draw Text Box Gß£øua ö\õhUQ _miø¯ 

AÊzv¯ÁõÖ ÷uøÁ¯õÚ AÍÂØS 3 GÊzx¨ ö£miPøÍ 

Áøμ¢x öPõÒÍÄ®. ÷©÷» ö£miPÐUSÒ Põmh¨£mkÒÍ 

ÁØøÓ umha_ ö\´¯Ä®. 
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£i•øÓ 16 - GÊzx¨ ö£mi°ß Pøμø¯ Aø©¨£uØS, Auß «x 

_miø¯a ö\õhUQ GÊzx¨ ö£miø¯z öu›Äö\´x 

öPõÒÍÄ®. £mi°À  Format → Shape  ‰»® ö£õ¸zu©õÚ 

ÁiÁzøuz öu›Ä ö\´P.

ABC Kinder School

£i•øÓ 17  - ÁiÁ® ÷uøÁ¨£k® ChzvÀ _miø¯a ö\õhUPÄ®.

£i•øÓ 18  - Insert → Shape Gß£øua  ö\õhUQ ÷uøÁ¯õÚ ÁiÁzøuz 

BÁnzvÀ Áøμ¢x öPõÒÍÄ®.

ÁiÁzvÝÒ GÊzxUPÒ Aø©zuÀ

£i•øÓ 19  - ÁiÁzvß «x _mi°ß Á»x ö£õzuõøÚa ö\õhUQ  
Add Text Gß£øuz öu›Äö\´¯Ä®.

£i•øÓ 20  - ÷uøÁ¯õÚ GÊzxUPøÍ AuÝÒ umha_ ö\´¯Ä®.

£i•øÓ 21  - ÁiÁzøu öu›Äö\´x   £mi°À  Drawing Tools →
Format Gß£v¾ÒÍ  ö£õ¸zu©õÚ ÁiÁø©¨¦PøÍa 

ö\´¯Ä®. (Áºn®, Pøμ Gß£Ú)

BÁnzvØS £UPU Pøμ ÷\ºzuÀ

£i•øÓ  22 - £mi°À Design → Page Borders → Art Gß£uÞhõP 

ö£õ¸zu©õÚ £UPU Pøμø¯z öu›Äö\´x OK ö\´¯Ä®.

£i•øÓ  23 - BUPzøua ÷\ªUPÄ®.

BÁnzvØS ÁiÁ[PÒ ÷\ºzuÀ
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ö\¯Ø£õk 3.7  

1. E©x £õh\õø» {PÌa] JßÔØPõÚ AøÇ¨¤uÌ JßøÓz 

u¯õ›UPÄ®.

2. E©x |s£Ûß ¤Ó¢u vÚzøu •ßÛmk ÁõÌzx Amøhö¯õßøÓz 

u¯õ›UPÄ®.

3. "Let's  protect  the  Environment " GÝ® uø»¨¤À _Áöμõmiö¯õßøÓz 

u¯õ›UPÄ®.

ö\¯Ø£õk 3.8

• AmhÁøn E¸ÁõUPÀ

{μÀPøÍ²® (Rows) {øμPøÍ²® (Columns) öPõsh Aø©¨¦ 

AmhÁøn GÚ¨£k®. {μ¾® {øμ²® JßÖ÷\¸® Ch® P»® (Cell) 
GÚ¨£k®.

    

{øμ

{μÀ P»®

CÆÁmhÁøn°À 4 {μÀPÐ® 3 {øμPÐ® 12 P»[PÐ® EÒÍÚ.

•  R÷Ç Põn¨£kQßÓ AmhÁøn°À EÒÍ {μÀPÒ,  {øμPÒ, 

P»[PÒ Gß£ÁØÔß GsoUøP ¯õx?

³ {μÀPÒ  = ...................................
³ {øμPÒ  = ..................................
³ P»[PÒ  = ..................................
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ö\¯Ø£õk 3.9

• R÷Ç Põn¨£kQßÓ AmhÁønø¯ Bμõ´P. CÆÁõÓõÚ Amh 

Áønø¯ u¯õ›US®÷£õx ¤μ÷¯õQUP¨£mkÒÍ ÁiÁø©¨¦PøÍ 

Aøh¯õÍ® PõsP.

1 2 3 4 5 6 7 8 9 10 11 12
1 1
2 2 4
3 3 9
4 4 16
5 5 25
6 6 36
7 7 49
8 8 64
9 9 81
10 10 100
11 11 121
12 12 144

² Cx ö£¸UPÀ AmhÁønö¯õßÓõS®.

² C[S 13 {μÀPÐ® 14 {øμPÐ® EÒÍÚ.

² •u»õÁx {øμ°¾ÒÍ AøÚzx P»[PøÍ²® ÷\ºzx J¸ P»©õP 

Aø©UP¨£mkÒÍx.

² uø»¨¦ ö\õØPø» (Word Art ) ‰»® E¸ÁõUP¨£mkÒÍx.

² AmhÁøn°À EÒÍÁõÖ {μÀ, {øμ, P»® Gß£Ú Áºn 

©õUP¨£mkÒÍÚ.  

² umha_ ö\´¯¨£mh C»UP[PÒ P» ©zv°À {ø»¨£kzu¨ 

£mkÒÍÚ.

CÆÁõÓõÚ AmhÁønö¯õßøÓ E¸ÁõUS÷Áõ®.
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 {μÀ, {øμ Gß£ÁØøÓ¨ ö£ØÖUöPõÒÍÀ

£i•øÓ  1 -  Insert → Table → Insert Table

£i•øÓ 2 -  Eøμ¯õhÀ ö£mi°À ÷uøÁ¯õÚ  

{μÀ,   {øμ Gß£ÁØÔß GsoU 

øPPøÍ  SÔ¨¤mk  OK
PmhøÍø¯a ö\õhUPÄ®.

£i•øÓ 3 -  Caö\¯¾USz ÷uøÁ¯õÚ P»[PøÍ _mi°ß ‰»® 

öu›Äö\´x öPõÒÍÄ®. 

£i•øÓ 4 -  £mi°À öuß£k® Table Tools →  Layout → Merge Cells 
Gß£øuz öu›Äö\´¯Ä®.

£i•øÓ 5 -  •u»õÁx {øμ°À _miø¯a ö\õhUPÄ®

£i•øÓ 6 -  £mi°À Insert → Word Art öu›Äö\´¯Ä®.

£i•øÓ 7 -  }º Â¸®¤¯ ö\õØPø» ÁiÁzøuz öu›Äö\´¯Ä®.

£i•øÓ 8 -  ÷uøÁ¯õÚøuz umha_ ö\´¯Ä®.

£i•øÓ 9 -  Áºn©õUPz ÷uøÁ¯õÚ P»zvÝÒ ö\õhUPÄ®.

£i•øÓ 10 -  £mi°À Home → Shading Gß£øua ö\õhUQ 

÷uøÁ¯õÚ Áºnzøuz öu›Äö\´¯Ä®.

A

{μÀ, {øμ, P»® Gß£ÁØøÓ Áºn©õUPÀ

Cμsk AÀ»x AuØS ÷©Ø£mh 

P»[PøÍ uÛU P»©õP ©õØÖuÀ

uø»¨¤ØS ö\õØPø» ¤μ÷¯õQzuÀ
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ö\¯Ø£õk 3.10

• E©x ÁS¨£øÓUSz ÷uøÁ¨£kQßÓ AmhÁønPøÍ E¸ÁõUPÄ®.

Euõμn® &  ÷|μ AmhÁøn, |À» ö\¯ÀPøÍU SÔzx øÁ¨£uØPõÚ 

J¸ AmhÁøn ÷£õßÓøÁ.

£i•øÓ 11 -   P»zvÝÒ ÷uøÁ¯õÚ C»UP[PøÍ 

AÀ»x GÊzxUPøÍz umha_ 

ö\´¯Ä®.

£i•øÓ 12 -  _miø¯a ö\õhUQ •Ê Amh 

Áønø¯²® öu›Äö\´x öPõÒÍÄ®.

£i•øÓ 13 -   £mi°À Table Tools → Layout → Alignment FhõP 

÷uøÁ¯õÚ ÷|º¨£kzuø»z öu›Äö\´¯Ä®.

£i•øÓ 14 -  E¸ÁõUP¨£mh     AmhÁøn²hß    Ti¯   BÁnzøua  

÷\ªzu ¤ß ‰i ÂhÄ®.

umha_ ö\´u C»UP[PøÍU  P»zvß ©zv°À ÷|º¨£kzuÀ
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ö\´{μ»õUP®4
ö\¯Ø£õk 4.1

R÷Ç Põn¨£kQßÓ ¤μ]Ú[PøÍ Bμõ´¢x EÒÏk, •øÓÁÈ¯õUP®, 

Á¸ÂøÍÄ  BQ¯ÁØøÓ ÷ÁÖ£kzvU PõmhÄ®.

(A) Á¯x 18 AÀ»x AuØS AvP® GÛß  ""ÁõUSa ö\¾zu •i²®'' 18 
¾® SøÓÄ GÛß ""ÁõUSa ö\¾zu •i¯õx''.

(B) Cμsk SÊUPÐUQøh°À |øhö£Ö® ÷£õmiö¯õßÔÀ HuõÁx 

J¸ SÊ öÁØÔ ö£ÖuÀ AÀ»x öÁØÔ ÷uõÀÂ°ßÔ •iÁøhuÀ.

ö\¯Ø£õk 4.2

  ÷©÷» 4.1 (A) ‰»® £S¨£õ´Ä ö\´u ¤μ]øÚUSU R÷Ç 

uμ¨£mkÒÍ £õ´a\Ø÷Põmk¨ £hzvß wº©õÚ¨ ö£miUS›¯ a, b
BQ¯ÁØÓõÀ SÔUP¨£k®  CøhöÁÎPøÍ {μ¨£Ä®.

Bμ®£®

•iÄ

'''''''' 

'''''''

Á¯x <18

Á¯øu EÒÏk ö\´P

    ""ÁõUSa ö\¾zu •i²®''

""ÁõUS ö\¾zu •i¯õx''

a

b
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÷©¾ÒÍ £õ´a\Ø÷Põmk¨ £hzvØPø©¯ RÊÒÍ TØÖUPøÍU  P¸xP. 

A - öuõh› ©õzvμ® öPõshx

B - öu›Ä ©õzvμ® öPõshx

C - öuõh›ø¯²® öu›øÁ²® öPõshx

÷©¾ÒÍ TØÖPÐU÷PØ£, 

1.  A ©õzvμ® Esø©¯õS®    2.  B ©õzvμ® Esø©¯õS®    
3.  C ©õzvμ® Esø©¯õS®    4.  JßÖ÷© Esø©°Àø»

ö\¯Ø£õk 4.3

÷©÷» 4.1 (B) ‰»® £S¨£õ´Ä ö\´u ¤μa]øÚUSU R÷Ç uμ¨£mkÒÍ 

£õ´a\Ø÷Põmk¨ £hzvß wº©õÚ¨ ö£miUS›¯ x, y BQ¯ÁØÓõÀ 

SÔUP¨£k®  CøhöÁÎPøÍ {μ¨£Ä®.

Bμ®£®

•iÄ

B®

CÀø»

CÀø»

B®

A- ¦ÒÎ >B-
¦ÒÎ

A- ¦ÒÎ <B-
¦ÒÎ 

Cμsk SÊUPÐ® ö£ØÖÒÍ 

¦ÒÎPøÍ A- ¦ÒÎ,  B - ¦ÒÎ 

GÚ¨ö£ØÖU öPõÒP.

zzöÁØÔ ÷uõÀÂ°ßÔ •iÁøhQÓxZZ

zz''''''''''' öÁØÔZZ

zz''''''''''' öÁØÔZZx

y
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÷©¾ÒÍ £õ´a\Ø÷Põmk¨ £hzvØPø©¯ EÒÏkPÎß GsoUøP²® 

Á¸ÂøÍÄPÎß GsoUøP²® •øÓ¯õPU PõmkÁx,

    1)   2, 1            2)   3, 1       3)   1, 3           4)   3, 2

ö\¯Ø£õk 4.4

RÊÒÍ Scratch TØÖUPÎß CÖv Á¸ÂøÍøÁU PõsP. A Gß£x J¸ 

©õÔ¯õS®.

.................

.................

.................

ö\¯Ø£õk 4.5

RÊÒÍ TØÖUPÎß CÖv Á¸ÂøÍøÁ FQUPÄ®. A Gß£x ö\¯Ø£õk 

4.4 CÀ Põmh¨£mh ©õÔ¯õS®. Cuß ö£Ö©õÚ® 15 GÚU öPõÒP.

Esø© $ ö£õ´

Esø© $ ö£õ´

Esø© $ ö£õ´

Esø© $ ö£õ´
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ö\¯Ø£õk 4'6

 ^A& ÷©÷» 4.2 CÀ Áøμ¯¨£mh £õ´a\Ø÷Põmk¨ £hzvØPõÚ Scratch 
ö\´{μø» E¸ÁõUPÄ®.

^B& ÷©÷»  4.3 CÀ Áøμ¯¨£mh £õ´a\Ø÷Põmk¨ £hzv¾ÒÍ   

CøhöÁÎPøÍ {μ¨¤ Scratch ö\´{μø» E¸ÁõUPÄ®.

ö\¯Ø£õk 4'7

RÊÒÍ £õ´a\Ø÷Põmk¨ £hzvß a, b, c, d BQ¯ÁØÔß ‰»® 

Põmh¨£mkÒÍ CøhöÁÎPøÍ RÌÁ¸® £u[PøÍU öPõsk 

{μ¨£Ä®.

CøhöÁÎPøÍ {μ¨¦ÁuØS¨ ö£õ¸zu©õÚ £u[PÎß £mi¯À;

(•iÄ, AP»®, CÀø», B®)

Bμ®£®

 ............

}Í® ©ØÖ®  ''''''' Gß£ÁØøÓ EÒÏk ö\´P
(a)

...... ......
}Í•® AP»•®

\©©õÚøÁ¯õ?

""\xμ®'' GÚU 

PõmhÄ®

""ö\ÆÁP®'' GÚU 

PõmhÄ®

(b) (c)

(d)



35

ö\¯Ø£õk 4'8

RÊÒÍ £õ´a\Ø÷Põmk Áøμ£hzvß CøhöÁÎPøÍ {μ¨£Ä®.

•iÄ

\©ÚØÓ Cμsk ö£Ö©õÚ[PøÍ (A, B) EÒÏk ö\´P

CÀø»     B®
A < B ?

''''''''''' ]Ôx 

GÚU PõmhÄ®

'''''''''' ]Ôx 

GÚU PõmhÄ®

Bμ®£®
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  ö\¯Ø£õk 4'9

ÁS¨¤ß ö£¯º Chõ¨ø£ 

£vÄ ö\´²®÷£õx ©õnÁº  

Á¢xÒÍõº GÛß 1 GÚÄ®, 

ÁμÂÀø» GÛß 0 GÚÄ® 

£v¯¨£kQÓx. AuØS¨ 

ö£õ¸zu©õÚ Scratch ö\´{μÀ 

C[÷P Põmh¨£mkÒÍx.   

A, B ©ØÖ® C BQ¯ÁØÔß 

Ch[PÐUS¨ ö£õ¸zu©õÚ 

AÔÄÖzuÀ öuõSv°ß C»U 

PzøuU SÔ¨¤hÄ®.

A  =  .........................
B  =  .........................
C  =  .........................

1

2

3

©õnÁº Á¢xÒÍõμõ?

B®

ÁμÄ 0 GÚ¨ £vP

ÁμÄ 1 GÚ¨ £vP

ö\¯Ø£õk 4'10

£õh¡¼À Põmh¨£mkÒÍ  JÆöÁõ¸   `miøPa \õuÚ[PøÍ²® 

AÁØÔß ¤μ÷¯õP[PøÍ²® £mi¯¼hÄ®.
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}[PÒ CuØS •ß ÂÍ[QUöPõsh u¸UP¨ £hø»PÎß 

ö\¯Ø£õkPøÍ  ö©ßö£õ¸Ò ‰»® AÔ¢x öPõÒÍ •iÁxhß AuØS Multi 
Media Logic (MM Logic) GÝ® ö©ßö£õ¸Ò C[S £¯ß£kzu¨£kQÓx.

MultiMedia Logic ö©ßö£õ¸ÎøÚ £vÂÓUP® ö\´x (Download)
{ÖÂU (Install) öPõÒP. Auß Bμ®£ £¯Úº Cøh•P® E¸ 5.1 CÀ EÒÍÁõÖ 

Põn¨£k®.

£hø»PÎß ö\¯Ø£õkPøÍ ö©ßö£õ¸Ò ‰»® AÔ¢x öPõÒÍÀÀÀ

MultiMedia Logic  ö©ßö£õ¸Ò

ö£ÍvPU PozuÀPÐUPõÚ 

ö©ßö£õ¸Ò £¯ß£õk5

ö\¯Ø£õk 5.1

R÷Ç Põn¨£kQßÓ _ØÖPÎÀ ÁÇ[P¨£mkÒÍ EÒÏkPÐUS¨ 

ö£õ¸zu©õÚ Á¸ÂøÍøÁ GÊvUPõmhÄ®.
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E¸ 5.1

Toggle Palette

Selector

AND Gate

NOT Gate

Switch

Buzzer

Wire

Node

OR Gate

LED

Text

Menu Bar

Toggle Palette Window

Tool Bar

Multimedia Logic - Logic 1

File

Palette

Palette

Edit Set Draw Simulate View Window
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P¸Â¨£møh (Tool  Bar) C¾ÒÍ  SÔ±miß«x ö\õhUQ Toggle Palette 
CøÚ¨ ö£ØÖUöPõÒÍ»õ®.

Toggle Palette C¼¸¢x LED JßøÓ²® Switch  JßøÓ²® ö£ØÖ GÎ¯ _ØÖ 

JßøÓU Pmiö¯Ê¨¦÷Áõ®.

LED ø¯ Window «x öPõskÁ¸uÀ

Switch ø¯ Window «x öPõskÁ¸uÀ

P®¤°øÚ¨ (Wire) £¯ß£kzv Switch, LED 
BQ¯ÁØøÓ CønzuÀ

Tool Bar CÀ Põn¨£kQßÓ Run 
Gß£øua ö\õhUQ Window C¾ÒÍ

Switch ‰»® RÌU Põmh¨£mkÒÍÁõÖ 

EÒÏkøÍ ©õØÓ»õ®.

Switch 0 BP C¸US® \¢uº¨£zvÀ LED 
G›¯õx.

Switch  1 BP  C¸US®  \¢uº¨£zvÀ 

LED  G›²®.

Run

MultiMedia Logic ö©ßö£õ¸øÍ¨ £¯ß£kzuÀ
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÷©¾ÒÍÁõÖ _ØøÓ Aø©zx Run ö\´²®÷£õx Auß Á¸ÂøÍøÁ 

RÊÒÍÁõÖ AÁuõÛUP •i²®.

SWITCH 1 CÀ BP AuõÁx, ªß\õμ® ÁÇ[P¨£k®÷£õx LED G›¯õx.

SWITCH  0 CÀ BP AuõÁx, ªß\õμ® ÁÇ[P¨£hõu÷£õx LED G›²®.

MultiMedia Logic ö©ßö£õ¸øÍ¨ £¯ß£kzv Ai¨£øhz u¸UP¨ 

£hø»PÎß ö\¯Ø£õkPøÍ¨ £Ÿm]zuÀ

NOT £hø» 

A

A

A
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÷©¾ÒÍÁõÖ _ØøÓ Aø©zx Run ö\´²®÷£õx Auß Á¸ÂøÍøÁ 

RÊÒÍÁõÖ AÁuõÛUP •i²®.

A, B BQ¯ C¸ Switch PÎ¾® 0 EÒÏk ö\´¯¨£k®÷£õx LED G›¯õx. 

AND £hø»

ö\¯Ø£õk 5'2

MultiMedia logic ö©ßö£õ¸øÍ¨ £¯ß£kzv NOT £hø»  ö\¯Ø 

£kzu¨£k®÷£õx ©õÖ£kQßÓ EÒÏk, Á¸ÂøÍÄ Gß£ÁØøÓ 

AmhÁøn¨£kzxP.  

A

A

B

B
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A  Switch ‰»® 1 E® B Switch ‰»® 0 E® EÒÏk ö\´¯¨£k®÷£õx LED
G›¯õx.

A  Switch ‰»® 0 E® B Switch ‰»® 1 E® EÒÏk ö\´¯¨£k®÷£õx LED
G›¯õx.

A , B BQ¯ Cμsk Switch PÎ¾® 1 EÒÏk ö\´¯¨£k®÷£õx LED G›²®.

A

A

A

B

B

B
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OR £hø»  

÷©¾ÒÍÁõÖ _ØøÓ Aø©zx Run ö\´²®÷£õx Auß Á¸ÂøÍøÁ 

RÊÒÍÁõÖ AÁuõÛUP •i²®.

A , B BQ¯ Cμsk Switch PÎ¾® 0 EÒÏk ö\´¯¨£k®÷£õx LED G›¯õx.

ö\¯Ø£õk 5'3

MultiMedia logic ö©ßö£õ¸øÍ¨ £¯ß£kzv AND £hø»  ö\¯Ø£kzu¨ 

£k®÷£õx ©õÖ£kQßÓ EÒÏk, Á¸ÂøÍÄ Gß£ÁØøÓ AmhÁøn¨ 

£kzxP. 
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A Switch ‰»® 1 E®, B Switch ‰»® 0 E® EÒÏk ö\´¯¨£k®÷£õx LED
G›²®.

A Switch ‰»® 0 E®, B Switch ‰»® 1 E® EÒÏk ö\´¯¨£k®÷£õx LED
G›²®.

Cμsk Switch PÎ¾® 1 EÒÏk ö\´¯¨£k®÷£õx LED G›²®.
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RÌ Põn¨£kQßÓ _ØÔøÚ MultiMedia Logic  ö©ßö£õ¸øÍ¨ £¯ß£kzv 

ö\´x PõmhÀ.

CuøÚ ö©ßö£õ¸ÎÀ E¸ÁõUQ¯x® RÊÒÍÁõÖ Aø©²®.

ö\¯Ø£õk 5'4

MultiMedia Logic  ö©ßö£õ¸øÍ¨  £¯ß£kzv  OR £hø»  ö\¯Ø£kz 

u¨£k®÷£õx ©õÖ£kQßÓ EÒÏk, Á¸ÂøÍÄ Gß£ÁØøÓ Amh 

Áøn¨£kzxP.

£hø»PÎß JßÔøn¨£õÀ E¸ÁõS® _ØÖPÎß Á¸ÂøÍøÁ 

MultiMedia  Logic ö©ßö£õ¸øÍ¨ £¯ß£kzv¨ ö£ØÖUöPõÒÍÀ.
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Cøu Run ö\´x, Cuß EÒÏkPøÍ ©õØÖ®÷£õx, Á¸ÂøÍÄ RÊÒÍ 

AmhÁøn°À Põmh¨£mkÒÍÁõÖ Aø©²®. (Á¸ÂøÍÄ 1 Gß£x 

LED JÎ¸® Gß£øu²® Á¸ÂøÍÄ 0 Gß£x LED JÎμõx Gß£øu²® 

PõmkQÓx.)

A B C Á¸ÂøÍÄ

0 0 0 1
0 0 1 0
0 1 0 0
0 1 1 0
1 0 0 0
1 0 1 0
1 1 0 0
1 1 1 0
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RÊÒÍ JÆöÁõ¸ _ØøÓ²® MultiMedia Logic  ö©ßö£õ¸øÍ¨ £¯ß 

£kzv E¸ÁõUQ EÒÏk, Á¸ÂøÍÄ Gß£ÁØøÓ AmhÁøn¨£kzxP. 

ö\¯Ø£õk 5'5
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Cøn¯zvÀ E»õÄ÷Áõ®6

ö\¯Ø£õk 6.1

Cøn¯zvØS ¤μ÷Á]zx G©x £õhzvØSz ÷uøÁ¯õÚ uPÁÀPøÍz 

vμmk÷Áõ®.

∙ PoÛ JßøÓ AÀ»x ö\À¼hz öuõø» 

÷£] JßøÓ¨ £¯ß£kzuÄ®.

∙ Cøn¯zvØS¨ ¤μ÷Á]¨£uØS Cøn¯ 

÷\øÁ ÁÇ[S® (Internet Service 
Provider - ISP) J¸ {ÖÁÚzvß ‰»® 

E©x \õuÚzvØS Cøn¯ Á\vø¯¨ 

ö£ØÖUöPõÒÍ ÷Ásk®.

∙ Áø» ÷©÷»õi ö©ßö£õ¸öÍõßÖ 

E©x  \õuÚzvÀ {ÖÁ¨£mi¸UP  

÷Ásk®.

∙ AuøÚ vÓ¨£uß ‰»® Cøn¯zxhß öuõhºø£ HØ£kzvU 

öPõÒÍ •i²®.

Áø» ÷©÷»õi (Internet Browser) ö©ßö£õ¸ÒPÒ GßÓõÀ GßÚ? 

² Áø»÷©÷»õi¯õÚx E[PÐUS® 

(£¯Úº & User)     Cøn¯zvØS®  

Cøh ÷¯ öuõhºø£ HØ£kzxQÓx.

² ¤μ£À¯©õÚ ]» Áø»÷©÷»õiPÒ 

C[÷P Põmh¨£mkÒÍÚ.  CÁØøÓz 

uÂμ ÷©¾® £» Áø»÷©÷»õiPÒ 

EÒÍÚ.
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Cøn¯zøu¨ £¯ß£kzv uPÁÀPøÍz ÷uhÀ

Cøn¯zøu¨ £¯ß£kzx®÷£õx ÷uøÁ¯õÚ uPÁÀPøÍz ÷uiU 

öPõÒÁuØS ÷uhØ ö£õÔ (Search Engine) JßÔøÚ¨ £¯ß£kzu»õ®. 

¤μuõÚ ÷uhØ ö£õÔPÒ ]» C[÷P uμ¨£mkÒÍÚ. CÁØøÓz uÂμ 

÷©¾® £» ÷uhØ ö£õÔPÒ EÒÍÚ.

1. Áø»÷©÷»õi ‰»® Cøn¯zøu AqQ¯x® E[PÐUSU 

RÊÒÍÁõÓõÚ Cøn¯¨ £UPö©õßøÓU PõnUTi¯uõP 

C¸US®. A¨£UP® }[PÒ £¯ß£kzx® Áø»÷©÷»õiUS Aø©¯ 

©õÖ£k®.

2. }[PÒ ÷uh÷Ási¯ uPÁ¼ß Bμ®£a ö\õÀø»z umha_ 

ö\´¯Ä®. A¨÷£õx Aaö\õÀ¼À Bμ®¤US® ÷ÁÖ uPÁÀPÐhß 

öuõhº¦øh¯ uø»¨¦PÒ £»ÁØÔß £mi¯ö»õßøÓU 

PõnUTi¯uõP C¸US®. Av¼¸¢x  ÷uøÁ¯õÚ uø»¨ø£z 

öu›Äö\´x  öPõÒÍ»õ®  AÀ»õÂiß  ÷uøÁ¯õÚ ö\õÀø»/ 

ö\õØöuõhøμ umha_ ö\´xöPõÒÍÄ®.

C[÷P umha_ ö\´¯Ä®
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3.  E©USz ÷uøÁ¯õÚÁõÖ ÷uhÀPøÍ ©õØÔUöPõÒÍ •i²®. 

AuØS RÊÒÍ £mi¯À £møh E[PÐUS EuÂ¯õP C¸US®.

AøÚzx 

uPÁÀPøÍ 

÷ukÁuØS

PõönõÎPÒ 

÷ukÁuØS

÷u\¨£h[PÒ 

÷ukÁuØS

E¸UPÒ 

÷ukÁuØS

ö\´vPÒ

÷ukÁuØS

ö\¯Ø£õk 6'2

PÀÂUS EuÂ¯õP Aø©²® Cøn¯z uÍ[PøÍ¨ £¯ß£kzv 

uPÁÀ ÷uhÀ.

E©x PÀÂUS £À÷ÁÖ ÁøPPÎÀ EuÂ¯õP Aø©¯UTi¯ Cøn¯z 

uÍ[PÒ Cøn¯zvÀ EÒÍÚ. CzuøP¯ Cøn¯z uÍ[PÎÀ 

PÀÂ¯ø©a]ß ""D&uU\»õÁ'' GÝ® Cøn¯z uÍzvØS •UQ¯ 

Ch® QøhUQÓx. CuøÚ £¯ß£kzxÁx E©x PÀÂ Âh¯[PÐUS 

÷£¸uÂ¯õP Aø©²®. CÆÁõÓõÚ Cøn¯z uÍ[PÒ ©ØÖ® Cøn¯z  

uÍ •PÁ›PÒ ]» R÷Ç uμ¨£mkÒÍÚ.

Ã ""D&uU\»õÁ'' (e-thaksalawa) http://www.e-thaksalawa.moe.gov.lk/
Ã PÀÂ öÁÎ±mkz vønUPÍ® (Educational Publications Depart-

ment) http://www.edupub.gov.lk/
Ã PÀÂ Aø©a_ (Ministry of Education) http://www.moe.gov.lk/tamil/

SÊUPÍõP Cøn¢x ÷©¾ÒÍ Cøn¯z uÍ[PøÍ¨ £õºøÁ°mk 

Auß ‰»® ö£ØÖUöPõsh uPÁÀPøÍ¨ £mi¯¼hÄ®.

÷\P›zu uPÁÀPøÍ HøÚ¯ SÊUPÐhß  £Qº¢x öPõÒÍÄ®.
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ö\¯Ø£õk 6'3

² Cøn¯¨ £UP® JßøÓz u¯õ›¨£uØS ÷uøÁ¯õÚ ö©ßö£õ¸øÍ 

Aøh¯õÍ® Põn ÷Ásk®.

² Cøn¯¨ £UPzvØS £h[PÒ CønUP¨£k©õ°ß AÁØøÓ 

•ßTmi÷¯ ÷Põ¨¦øÓ (Folder)  JßÔÀ ÷\ªzxUöPõÒÍ ÷Ásk®. 

(CÁØøÓ £¯ß£kzxÁuØS® ÷uiUöPõÒÁuØS® Cx C»SÁõP 

C¸US®)
² u¯õ›UP¨£kQßÓ AøÚzx Cøn¯¨ £UP[PøÍ²® A÷u ÷Põ¨¦øÓ 

°ÝÒ ÷\ªUP ÷Ásk®.

Tiny Little Bee Brian

Bees fl y from fl ower to fl ower, sipping nectar and collecting grains 
of pollen. Bees have a special tongue that sucks up the nectar and 
a crop in their throat for storing it until they get back to the hive, 
where it is turned into honey to use as food.

More about Bees

Notepad £¯ß£kzv Cøn¯¨ £UPö©õßøÓ E¸ÁõUS÷Áõ®.

£i•øÓ 1 - Notepad ö©ßö£õ¸øÍz    
  vÓ¢x öPõÒÍÄ®.

£i•øÓ 2 - Cøn¯¨ £UPö©õßøÓ E¸ÁõUSÁuØS Põmh¨£mkÒÍ  

  JmkPøÍ (Tags) AvÀ umha_ ö\´¯Ä®.

<html>
 <head>
  <title></title>
 </head>
</html>

Cøn¯¨ £UPö©õßøÓz u¯õ›zuÀ
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£i•øÓ 3 -  Cøn¯¨ £UPzvØS¨ ö£õ¸zu©õÚ ö£¯º JßøÓ ÁÇ[P 

÷Ásk®. Aøu CÆÁõÖ <title> Bees </title> JmkPÐUS 

Cøh°À umha_ ö\´¯Ä®.

<html>
 <head>
  <title>Bees</title>
 </head>
</html>

£i•øÓ 4 -  ÷Põ¨ø£a ÷\ªUPÄ® 

File → Save → Cøn¯¨ £UPzvØSz ÷uøÁ¯õÚ £h[PÒ ÷\ªUP¨ 

£mi¸US® ÷Põ¨¦øÓø¯z  vÓ¢x File name → Bees.html GÚ umha_ 

ö\´¯Ä®.

PÁÚzvØS - Cøn¯¨ £UPö©õßøÓa ÷\ªUS®÷£õx 

÷Põ¨¦¨ ö£¯¸hß .html GÝ® }m] ÁÇ[P¨£h 

÷Ásk®.

÷Põ¨¦¨ ö£¯º

Bees.html

÷Põ¨¦ }m]

£i•øÓ 5 - }[PÒ E¸ÁõUQ¯ ÷Põ¨¦øÓø¯z vÓ¢x Bees.html
GÝ® ÷Põ¨¦  «x  _miø¯a  ö\õhUQ  vÓ¢x  öPõÒÍÄ®. 

}[PÒ £¯ß£kzx® Áø» ÷©÷»õi°ÝÒ Cx vÓUP¨ 

£kÁxhß Cøn¯¨ £UPzvß ö£¯º R÷Ç ÁmhªmkU 

Põmh¨£mkÒÍÁõÖ C¸US®.

fi le:///D:/HoneyBees/Bees.html

£i•øÓ 6 - Cøn¯¨ £UPzvØS uø»¨ö£õßøÓa ÷\ºzuÀ

£hzvÀ   Põmh¨£mkÒÍÁõÖ  <body></body>   GÝ®   JmkPøÍa      

÷\ºzx AÁØÔØS Cøh°À Tiny Little Bee Brain  GÝ® uø»¨ø£ 

umha_ ö\´¯Ä®.
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<h1>Heading 1</h1>
<h2>Heading 2</h2>
<h3>Heading 3</h3>
<h4>Heading 4</h4>
<h5>Heading 5</h5>
<h6>Heading 6</h6>

•¯Ø]UPÄ®

<html>
 <head>
  <title>Bees</title>
 </head>
 <body>
 <h1> Tiny Little Bee Brain </h1>
 </body>

</html>

£i•øÓ 7 - Cx J¸ uø»¨¦ Gß£uõÀ 

CuøÚ <h1></h1> GÝ® 

JmkPÐUQøh°À 

umha_  ö\´¯ ÷Ásk®.

£i•øÓ 8 -  uø»¨ø£, £UPzvß ©zv°À Aø©UP ÷Ásk®. AuØS

<center></center> GÝ® Jmøh CÆÁõÖ £¯ß£kzuÄ®.

<html>
 <head>
  <title>Bees</title>
 </head>
<body>
  <h1><center> Tiny Little Bee Brain</center> </h1>
</body>

</html>
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£i•øÓ 9 -  ÷Põ¨ø£   «sk®  ÷\ªUPÄ®. ¤ßÚº «sk® vÓ¢x  

£õºUPÄ® AÀ»x Áø»÷©÷»õi°øÚ¨ ¦x¨¤UPÄ® 

(Refresh). 
JÆöÁõ¸ ©õØÓzvß ¤ß¦® ÷Põ¨ø£a ÷\ªzx AuøÚ  Áø» 

÷©÷»õi°À £õº¨£uß ‰»® }[PÒ ¤μ÷¯õQzxÒÍ JmkUPÒ ©ØÖ® 

©õØÓ[PÒ Gß£Ú £ØÔ ÂÍ[QUöPõÒÍ •i²®.

£i•øÓ  10 -  Cøn¯¨ £UPzvØS  £h® JßøÓa ÷\ºzuÀ

<img src> Jmøhz öuõhº¢x £hzvß 

ö£¯º ©ØÖ® Auß ÷Põ¨¦ }m] (File 
Extension) BQ¯ÁØøÓa ÷\ºUP ÷Ásk®. 

÷Põ¨¦øÓ°À  C¸US® £h[PøÍa ÷\º¨£x 

C»SÁõÚuõS®.

÷Põ¨¦¨ ö£¯º

Bee1.png
÷Põ¨¦  }m]

£i•øÓ  11 -  £hzvß  £¸©ß  ö£›uõP  C¸US®÷£õx  AuøÚ  •øÓ 

¯õPU øP¯õÍÀ ÷Ásk®.

CuØS £hzvß E¯μ®, AP»® Gß£ÁØøÓU Pmk¨£kzx® JmkU 

PÎøÚ¨ £¯ß£kzu»õ®. £hzvß E¯μ®, AP»®  Gß£øÁ  Ãu[PÎÀ

25%, 50%, 15% CÆÁõÖ SÔUP¨£k®. RÊÒÍ EuõμnzvÀ E¯μ®, 

AP»® Gß£ÁØøÓU  PõmkÁuØS height  ©ØÖ® width GÝ® £s¦PÒ

(Attributes) £¯ß£kzu¨£mkÒÍÚ.

]» £s¦PÒ

color Áºn®

align ÷|º£kzuÀ

href «°øn¨¦

src £hC¸¨¤h® 

title uø»¨¦

width AP»® 

height E¯μ® 
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<html>
 <head>
  <title>Bees</title>
 </head>
<body>
  <h1><center> Tiny Little Bee Brain</center> </h1>
  <center><img src="1bee.png" height=25%, 
width=25%></center>
</body>

</html>

£i•øÓ  12 - £hzøu  £UPzvß  ©zv°À {Özx

 ÁuØS  <center></center> Jmk 

£¯ß£kzuÄ®.

£i•øÓ  13 -  Cøn¯¨ £UPzvØS £¢v 

ö¯õßøÓa ÷\º¨£uØS

<p></p> Jmøh¨ £¯ß£kzv AuØQøh°À RÊÒÍ £¢vø¯z umha_ 

ö\´¯Ä®.

Bees fl y from fl ower to fl ower, sipping nectar and collecting grains of 
pollen. Bees have a special tongue that sucks up the nectar and a crop in 
their throat for storing it until they get back to the hive, where it is turned 
into honey to use as food.

<html>
 <head>
  <title>Bees</title>
 </head>
<body>
  <h1><center> Tiny Little Bee Brain</center> </h1>
  <center><img src="Bee1.png" height=25%, 
width=25%></center>
  <p> Bees fl y from fl ower to fl ower, sipping nectar and 
collecting grains of pollen. Bees have a special tongue that sucks up the 
nectar and a crop in their throat for storing it until they get back to the 
hive, where it is turned into honey to use as food.
  </p>
</body>
</html>
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Tiny Little Bee Brian

Bees fl y from fl ower to fl ower, sipping nectar and collecting grains of 
pollen. Bees have a special tongue that sucks up the nectar and a crop 
in their throat for storing it until they get back to the hive, where it is 
turned into honey to use as food.

£i•øÓ  14 -  £¢v°ß GÊzx AÍøÁ Aø©¨£uØS <h3></h3>
  Gß£øu <p></p> JmiØS Cøh°À ChÄ®. 

<p><h3>Bees fl y from fl ower to fl ower, sipping nectar and collecting 
grains of pollen. Bees have a special tongue that sucks up the nectar 
and a crop in their throat for storing it until they get back to the hive, 
where it is turned into honey to use as food.
</h3></p>

  
Tiny Little Bee Brian

Bees fl y from fl ower to fl ower, sipping nectar and collecting grains of pollen. 
Bees have a special tongue that sucks up the nectar and a crop in their throat 
for storing it unit they get back to the hive, where it is turned into honey to 
use as food.

£i•øÓ  15 -  CÖv ÁõUQ¯zøua ÁiÁø©zuÀ.

R÷Ç Põmh¨£mkÒÍÁõÖ umha_ ö\´¯Ä®. C[S, GÊzx 

Áiø©¨ø£ \›ÁõP Aø©¨£uØS <i></i> GßÓ Jmk® GÊzx £¸©øÚ 

©õØÖÁuØS <h4></h4> GßÓ Jmk® £¯ß£kzu¨£mkÒÍx. 

More about Bees<h4><i>More about Bees</i></h4>
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£i•øÓ  16 -  Cøn¯¨£UP    GÊzxUPÐUS   Áºn®    ÁÇ[SÁuØS

<font></font> GÝ® Jmk® Color GÝ® £s¦® 

£¯ß£kzu¨£mkÒÍx. R÷Ç Põmh¨£mkÒÍ Euõμ 

nzvÀ EÒÍÁõÖ ÷uøÁ¯õÚ Ch[PÐUS Áºn® 

ÁÇ[P¨£mkÒÍx.

<h1><center> <font color="Navy">Tiny Little Bee Brain </font> </
center></h1>
<center><img src="Bee1.png" height=25%, width=25%></center>
<p><h3><font color="green">Bees fl y from fl ower to fl ower, sipping 
nectar and collecting grains of pollen. Bees have a special tongue that 
sucks up the nectar and a crop in their throat for storing it until they get 
back to the hive, where it is turned into honey to use as food.
</font></h3></p>
  
<h4><i><font color="red">More about Bees</font></i></h4>

ö\¯Ø£õk 6'4

Interesting Facts about Tiny Bee

² Bees have 5 eyes and 6 legs.
² Honey bees harvest nectar and pollen from fl owering plants. 
² A single bee can collect enough nectar to make 1/12 of a teaspoon 

of honey.
² Honey has Surprising Health Benefi ts.
² Honey bees are super-important pollinators for fl owers, fruits and 

vegetables.
² Honey bees live in large groups called colonies.
² An average beehive can hold around 50,000 bees. 
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÷©÷»²ÒÍ £hzvÀ Põmh¨£mkÒÍx ÷£õßÖ ¦v¯ Cøn¯¨ 

£UPö©õßøÓ E¸ÁõUS÷Áõ®. 

£i•øÓ 1 -  C[S ¤μ÷¯õQUP¨£mkÒÍÁõÖ,

a.  £UPzvß ö£¯º (Bee Facts) 
b.  uø»¨¦ (Interesting Facts about Tiny Bee)
c.  £h®

Gß£ÁØøÓ EÒÍhUQ, CxÁøμ }[PÒ PØÖU öPõsh JmkPøÍ¨ 

£¯ß£kzv, RÊÒÍ Euõμnzvß EuÂ²hß Cøn¯¨ £UPzvß 

•uÀ £Svø¯ E¸ÁõUQ,   E©x    ÷Põ¨¦øÓ°À  BeeFacts.html
GÝ®  ö£¯›À  ÷\ªUPÄ®.

<html>
       <head>
 <title>BeeFacts</title>
      </head>
 <body>
      <center><p><h2><i><font color="red">Interesting Facts 
about Tiny Bee </font> </i></h2></p>
  <img src="honey.png" height=25%, width=15%><img 
src="fl ower.png"></center>
                </body>
</html>

£i•øÓ 2 -  Cøn¯¨ £UPzvØS £mi¯ö»õßøÓa ÷\ºzuÀ

Cx J¸ SskUSÔ £mi¯À Gß£uõÀ, CuøÚ <ul></ul> GÝ® 

JmiÝÒ umha_ ö\´¯¨£h ÷Ásk®. Á›PøÍ  Aø©¨£uØS 

AuÝÒ <li></li> Jmk £¯ß£kzu¨£k®. AkzxÒÍ EuõμnzvÀ 

JÆöÁõßÖ® uÛz uÛ¯õP Aø©UP¨£mkÒÍx.

   ² <font color></font> Jmk £¯ß£kzv Áºn©õUP¨£mkÒÍx.

   ² <i></i> Jmk £¯ß£kzv GÊzxPÒ \›ÁõUP¨£mkÒÍx. 

   ² <h3></h3> Jmk £¯ß£kzv £¸©ß ©õØÓ¨£mkÒÍx.

<h4></h4> Jmk ©ØÖ® <center></center> GÝ® JmkPÒ 

£¯ß£kzu¨£mk, £mi¯¼ØS öÁÎ÷¯ CÖv ÁõUQ¯©õÚ Back to 
Home E¸ÁõUP¨£mkÒÍx.
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² Bees have 5 eyes and 6 legs
² Honey bees harvest nectar and pollen from fl owering plants 
² A single bee can collect enough nectar to make 1/12 of a teaspoon 

of honey
² Honey has surprising Health Benefi ts
² Honey bees are super-important pollinators for fl owers, fruits and 

vegetables
² Honey bees live in large groups called colonies
² An average beehive can hold around 50,000 bees

<html>
       <head>
 <title>BeeFacts</title>
      </head>
 <body>
      <center><p><h2><i><font color="red">Interesting Facts about 
Tiny Bee</font></i></h2></p>
<img src="honey.png" height=25%, width=15%><img src="fl ower.png"> 
</center>
<ul>
   <li><h3><i><font color="blue">Bees have 5 eyes and 6 legs.</i> 
</h3></li>
<li><h3><i><font color="green">Honey bees harvest nectar and pollen from 
fl owering plants.</i></h3></li>
<li><h3><i><font color="orange">A single bee can collect enough nectar to 
make 1/12 of a teaspoon of honey</i></h3></li>
<li><h3><i><font color="red">Honey has surprising Health Benefi ts </i> 
</h3></li>
<li><h3><i><font color="blue">Honey bees are super-important pollinators 
for fl owers, fruits and vegetables</i></h3></li>
<li><h3><i><font color="green">Honey bees live in large groups called 
colonies.</i></h3></li>
<li><h3><i><font color="orange">An average beehive can hold around 
50,000 bees.</i></h3></li>
</ul>
     <h4><center>Back to Home</center></h4>
 </body>
</html>

£i•øÓ 3 - E¸ÁõUPzøua ÷\ªUPÄ®.
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ö\¯Ø£õk 6'5

Cøn¯¨ £UP[PÐUQøh°À «°øn¨¦¨ ¤μ÷¯õQzuÀ

E¸ÁõUQ¯ C¸ Cøn¯¨ £UP[PøÍ²® «°øn¨¦ £¯ß£kzv 

JßÔ¼¸¢x ©ØöÓõßøÓ öuõhº¦£kzu •i²®.

£i•øÓ 1 - ÷\ªzx øÁUP¨£mkÒÍ C¸ Cøn¯¨ £UP[PøÍ²® 

CÚ[Psk öPõÒÍÄ®.

i. Bees.html
ii. BeeFacts.html

C¸ Cøn¯¨ £UP[PÎ¾® EÒÍ CÖv ÁõUQ¯[PøÍ «°øn¨¦ 

ö\´ÁuØS £¯ß£kzx÷Áõ®.

Bees.html - More about Bees

BeeFacts.html - Back to Home

£i•øÓ 2 - Notepad ö©ßö£õ¸ÎÀ C¢u Cμsk  ÷Põ¨¦PøÍ²® 

uÛz uÛ¯õP vÓ¢x öPõÒÍÄ®. CÖv ÁõUQ¯zvØS 

RÊÒÍÁõÖ <a href> </a> Jmk ‰»® «°øn¨¦ 

HØ£kzu¨£mkÒÍøuU PÁÛUPÄ®.

J÷μ ÷Põ¨¦øÓUSÒ C¸US® ÷Põ¨¦PÐUS «°øn¨¦ HØ£kz 

xÁx C»SÁõÚx Gß£uõÀ, Cøn¯¨ £UP E¸ÁõUPzvß÷£õx 

÷uøÁ¯õÚ AøÚzx ÷Põ¨¦PÒ, £h[PÒ, PõönõÎPÒ ÷£õßÓÁØøÓ 

J÷μ ÷Põ¨¦øÓUSÒ øÁzv¸¨£x •UQ¯©õS®.

Bees.html

BeeFacts.html

<a href="Bees.html"><h4><i><font color="red">Back to Home 
</font> </i></h4></a>

£i•øÓ   3 - ÷Põ¨¦PøÍa ÷\ªzxU öPõÒÍÄ®.

£i•øÓ   4 - Áø»÷©÷»õi°À vÓ¢xöPõÒÍÄ®.

<a href="BeeFacts.html"><h4><center>More about Bees </center>
</h4></a>
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ö\¯Ø£õk 6'7

Beautiful Waterfalls in Sri Lanka

Sri Lanka is home to more than 100 waterfalls and rivers which at 
the end of the day stops at the Indian Ocean. Some of the waterfalls 
are man-made but still doesn't stop short of being breath-takingly 
beautiful.

• Baker's Waterfall 
• Bambarakanda Ella
• Bopath Ella
• Devon Waterfall
• Diyaluma Waterfal
• Dunhinda Waterfall

More about waterfalls

ö\¯Ø£õk 6'6

1.  ÷uÜUPÒ £ØÔ¯ ÷ÁÖ uPÁÀPøÍz ÷uhÄ® (Types of Bees, Use of 
Honey to be Healthy, How to Protect Bees) AÁØÔØS öÁÆ÷ÁÖ  

Cøn¯¨ £UP[PøÍ E¸ÁõUPÄ®.

2.  «°øn¨¦ ‰»® AøÁ JÆöÁõßøÓ²® öuõhº¦£kzuÄ®.
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÷©÷» Põmh¨£mkÒÍ Cøn¯¨ £UP E¸ÁõUPzvß÷£õx ¤μ÷¯õQUP¨ 

£mkÒÍ JmkPÒ Ah[Q¯ BÁnö©õßÖ R÷Ç uμ¨£mkÒÍx. AvÀ 

Põn¨£kQßÓ   CøhöÁÎPøÍ {μ¨¤ BÁnzøu¨ §μn¨£kzuÄ®. 

<html>
……………..
………………Waterfalls</title>
</head>
<body>
<h1>……………...<font color="Navy"> Beautiful Waterfalls in Sri Lanka 
</font> </center> </h2> 
<center><……………….="waterfall.png" ></center>
<p><h2><……………………….="green"><center>Sri Lanka is home to 
more than 100 waterfalls and rivers which at the end of the day stops at the 
Indian Ocean. Some of the waterfalls are man-made but still doesn't stop 
short of being breath-takingly beautiful.</center></font>……………...<p>
……………<h2>
 <li><i>Baker's Waterfall </i></li>
 ……<i>Bambarakanda Ella</i></li>
 <li><i>Bopath Ella</i></li>
 <li><i>Devon Waterfall </i>…………
 <li><i>Diyaluma Waterfal</i></li>
 <li>………….Dunhinda Waterfall</i></li>
</h2></ul>  
<……………………="morefalls.html"><i><center>More about waterfalls 
…………………..<i></a>
………………………
……………………..


